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AMBER J. BELL

TRAINING DYNAMO, LLC

o Mlcrosoft MVP!

Over 20 years of Microsoft Dynamics GP
experience with customers across the USA!
 DUG Advisory Board Member
* GPUG All-Star
* Authored 2 GP Workbooks




Smartlist Options
VsS.
' Field Level Security
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What will you choose?

Field Level Security
* Hide Fields

* Require password to change
* Disable Fields
* Assigning to Users

SmartList Options & System Options

Default Maximum Records
Default Columns

Default “Go To”

Default Password & Visibility
Bonus System Settings!




Field Level Security

Before:

Field Security Maintenance

File Edit Tools Help

lad Save [5] Clear K Delete Sy Copy
Field Security ID HIDE DELETE PD
Description = of Screen
Product ID 0 Product Name
Form Name PM_Vendor_Maintenance
Window Name PM_Vendor_Maintenance
Field Name Delete Button
Security Mode |Hide Field v
I4 4 » Ml byField Securty D v

Microsoft Dynamics GP

Password ID

Yersion 14.00.698

- d X

sa Fabrikam, Inc. 4/12/2017

=

¥ 40

O e

j Vendor Maintenance

File Edit
H Save E] Clear

Vendor ID |

Tools

Options
7C Delete [W] Wiite Letters

S [ Hoid

Help

After:

Vendor Maintenance

File Edit
H Save EI Clear

Yendor ID |

Tools

Options

HEIp
Wiite Letters

Administration > Setup > System > Field Level Security

\ [ [ Hold




Assignh User Classes

User 1D
User Hame
Clazz D

margaret p D l%:
targaret balloy
&P CLERK B

[ ] web Client user only [ho SEL Server Account]

SOL Server dccount

SOL Server Account
Fazzword

Confirm Pazzword

I Directary Acocount I

margaret
FEFFEEEFRFEREE RN RS

&dvanced SOL Server options

SETUP: ADMINISTRATION > SETUP > USER CLASSES
ASSIGN: ADMINISTRATION > SETUP > USER

Status W
Uszer Type Full e
User Class Setup - TWO (sa)
~ » %
= X T = U @]

File Print  Tools Help Add

S5ave Delete = Additional
hd hd ¥  Note
Actions Additional File - Help
Class ID 4P CLEREK P OE, O Hefauit

Dezcription

4 4 » M

Enter [nvoices




Why U Seé * SmartList Favorites can be limited to specific Classes

c la S ses" * Field Level Security can be assigned by class
o
User Class Setup - TWO (sa) _ %

- N - I @

5ave Delete  Additional File Pnnt Toecls Help Add

i v *  Note
Actions Additional File -~ Help
Class ID 4P CLERK 2|07, [ Hefault
Description Enter lrvoices

4 4 »F M
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SmartList Options

ADMINISTRATION > SETUP > SYSTEM > SMARTLIST OPTIONS

P smartList Options - TWO (sa)

OX T L
O_K Cancel | Additional File | Tools | Help

- -

Actions Additional File ~ Help

d

X

Category Defaults

Cateqaony:

Default Go Ta Wigm

b awirum Records: 1,000

Aceount Mumber
Account Description
Paosting Type

Account Category Mumber
M ain Account Segment
[] Account Index

[ Account Aliaz

[] Segment

[] Segment2

td ark Al Unmark All Default

The zelections below will impact all SmartList Favorites:
Search Defaultz

] tark the Match Case checkbox by default when perfarming searches.
Enable the Match Case checkbowx on the SmartList 5earch window.
Password

Madify Srnartlizt Favorte | MOPE

(24l

(Lo




System Preferences

ADMINISTRATION > SETUP > SYSTEM > SYSTEM PREFERENCES

Options
[ ] Load To Da: Reminders by default on Home Page
[ ] Enable Remember Lzer

Drefault SmartList Yisibility: | User 1D w

Send Users Meszage
Enable Maotification Meszzage

1| Frequency to check for Motification Meszages [in Minutes]

Busineszs Analyzer

[ ] Dizplay Business Analyzer on Home page

[ ] Display Business Analyzer on M avigation List pages




SmartList Export Solutions
Vs.

Excel Reports
“ A o



What will you choose?

SmartList Export Solutions Excel Reports

* Create template in Excel or Word < How to enable Excel Reports
that connects to SmartList

, * Accessing Excel Reports
Favorites.

* Creating Pivot Tables

* Automatically Format . .
* Adding Slicers

* Automatically Add Formulas




Creating SmartList Export Solutions

®In Excel: File > Options > Customize Ribbons > Check Developer Ribbon
°In GP:
= Create: SmartList Favorite
= Save: Favorite
= Export: To Excel
°In Excel:
= Record: Macro(s)
= Save File As: Macro Enabled Template
v Tip: If you receive an error Document Not Found, the number of
characters in the path to your file + the file name is too long. Move the
Excel Macro Enabled Template to another folder and/or shorten the name.
®In GP: SmartList > SmartList > Export Solutions
= Assign: Macros




Step 1: Enable “Developer’ Ribbon in Excel

Excel Options

General
Formulas
Data
Proofing
Save
Language
Accessibility

Advanced

Customize Ribbon

Quick Access Too\ba‘

Add-ins

Trust Center

E% Customize the Ribbon.

Choose commands from:®

o

Click File > Options in Excel

\ Popular Commands

?Add or Remove Filters
1AIl Chart Types... [Create Chart]
Borders

Calculate Now

= Center

[Efconditional Formatting
[Bcopy

Custom Sort...

X Cut

A’ Decrease Font Size

B% Delete Cells...

LEJ Delete Sheet Columns
E" Delete Sheet Rows
OAEmail

LrFill Color

Font

AFont Color

Font Size
Format Cells
6Forma? Painter
*u:EFreeze Panes
A’Increase Font Size
ﬁ\nsert Cells...
ﬁr\nsert Function...
FClinsert Picture

[+]

Customize the Ripbon:G)

‘ Main Tabs

Main Tabs
> B Background Removal

> Home

> @ Insert

> [ Draw

> [ Page Layout

> EFormulas

> EData

> B Review

> EView

> B Automate

> [ Developer
E Add-ins

> EHelp

Customizations: 0

Import/Export ¥ [

0K I ‘ Cancel




Step 2: Export to Exce

ESmartLlst - TWO (sa)

T X L wEWQ

Mew Meodify Search Refresh Columns Favorites Print Excel | Word | Stop

Actions 4

é

i}

Expo

|

_I_r

Import
-

ETET

2

SmartList | Additional

Options

—s

-

Additional

File

-

File

it @

Tools

-

Help

Help

3 Item OQuantities - [tems by Site™
Eay

[tern Murmber Location Code Record Type Ty On Order
1-A32614 01-M Site 0
1-A34834 01-M Site 0
100XLG 01-M Site 0
128 SDRAM 01-M Site 0
1GPROC 01-M Site 0
2-A32844 01-M Site 0
24X IDE 01-M Site 0

Y On Hand

=T =T R = T = T = ]

Ony Allocated

0
0
0
0
0
0
0




Step 3: Save as Macro Enabled Template or Workbook

i iésc%
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£ Search

File Home Insert Draw Page Layout Formulas Data Review View Automate Developer Help
f&l [%S’ e Segoe Ul ~||9 ~ AA A = El = *}" v E(t'; Wrap Text General ~ ﬁ
Co| v -
Paste B copy u M A == == 5= Fx Fm ¢ of & €0 00 Conditior
~ @ Format Painter Excel Workbook (*.xlsx) prmatting
Clipboard = Excel Macro-Enabled Workbook (*.xlsm)
Excel Binary Workbook (*.xlsb)
Al - f Excel 97-2003 Workbook (*.xls)
CSV UTF-8 (Comma delimited) (*.csv)
A B XML Data (*.xml) G
l Ite';n Nurgber J‘I:_ﬁcaNt‘iﬁn Code Single File Web Page (*.mht;".mhtml) le 0
: . A ) LU *.htm;*.| | I
3 3.C2924A Web Page (*.htm;*.html) 20
4 13-D2657A i3l save As Excel Template (*.xItx) 30
5 3-D2659A Excel Macro-Enabled Template (*.xltm) 30
5 3-E4502A Excel 97-2003 Ti late (*.xt) -34
/" 3-£2094A « v 1 |[B [Excel 97- emplate (*xlt) 10
: 3-E4592A |Text (Tab delimited) (*.txt) -1.0
10 ;Eﬁggg Organize Nev{Unicode Text (*.txt) :}g
1T 4-E2094A XML Spreadsheet 2003 (*.xml) 0.0
1473-E4592A DCON LIVE - Microsoft Excel 5.0/95 Workbook (*.xls) -10
13 3-A3542A €SV (Comma delimited) (*.csv) 00
1413-B3813A © DynamicsCon| - 1.0
1; 3-E44T1A Formatted Text (Space delimited) (*.prn) 7.0
ACCS-CRD-12 SL Export : . 50.0
10 PHON-GTE.504 po Text (Macintosh) (*.txt) 150
T8 PHON-PAN-23! Text (MS-DOS) (*.txt) 360
19 PHON-ATT-071 KM Microsoft Excel CSV (Macintosh) (*.csv) 260
2U PHON-ATT-53! SV (MS-DOS) (* 26.0
21 PHON-ATT-53! ) |CSV (MS-DOs) (".csv) 220
ﬁ PHON-ATT-53| @ OneDrive - TraiDIF (Data Interchange Format) (*.dif) 13.0
PHON-ATT-53 ic Li " 8.0
24 PHON-ATT 23 . SYLK (Sympo\tc Link) (*.slk) 350
25 PHON-PAN-38! +# Training DynamExcel Add-in (*.xlam) 250
£ ]\ anc E%R&MDW Excel 97-2003 Add-in (*.xla) 1.555 ,g
-RST- = Thi . X
25 HOWR-CAB-00 This PC POF (*.pelf) T
29 HDWR-TPS-00! W on Akiae. KPS Document (“.xps) 1.0
g? ';HB%';{;QN'N Strict Open XML Spreadsheet (*.xlsx) 123
32 3013004A File name: gpenDocument Spreadsheet (*.ods) 10
3314-A3666A . g - v 20
j: ACts.CRD-12W Save as type: ‘Excel Macro-Enabled Template (*.xltm) o
3b 58%’?'{;;;'53 Authors:  Amber Bell Tags: Add atag ;g
30CELLA 67.0
5 oy i
20 3.83813A [] Save Thumbnail 460
41 3.C2024A 270
423 D2657A 300
43 3.D2659A 300
3‘: g-f;é;"l: A Hide Folders Tools = Cancel 4;3
45 PHON-ATT-53) -200
47 [PHON-RAS-0001  WARFHOLISF Site. 55.00000 n.onnnn 3.00000 520




Record a Macro in Excel

 Add Subtotals
* Format Page
e Add filters

Note: Adding totals vs. using the Subtotal feature requires using VBA
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Recording a Macro

SL Export_Item Quantity.... « Saved to this PC v

File Home Insert Draw Page Layout Formulas Data Review View Automate Developer Help
T [ 8 Record Macro | OB E | = b B | 5 E @ impor
-—- s= (=] 4 X [
Use Relative R f} ‘o] View Cod [£23] Expansion Packs [
Visual Macros FEH Use Relative Refer add- Excel COM Insert E“ rewode Source P
Basic A Macro Security in Add-ins Add-ins v El Run Dialog e
Code Add-ins Controls XML
Al - ] Record Macro ? X
A - ) Macro name: 1 i . - < . il 1 |
1 [item Number ILocation Code QTY Allocated QTY Available QTY Back Ordered
2 3-AZ440A 01-NW Format 0.00000 0.00000 1.00000 0.00000
3 13-C2924A 102G 0.00000 3.00000 2.00000 0.00000
4 3-D2657A 102G 0.00000 2.00000 3.00000 0.00000
> 3-D2659A 102G Shortcut key: 0.00000 ~
© 13-E4592A 107G 0.00000
é_4-E2094A 112B Crl+ 0.00000
|3-E4592A 115G 0.00000 -
5 3 E4300A 1236 — ocoonce |  Write down the name(s) of the
_1|_|73—E4592A 126G 0.00000
4-E2094A 1278 i v 0.00000
12 3_E4592A 127G This Workbook 0.00000 maC rOS you reCO rd "
13 13-A3542A DEPOT o 0.00000
?I;E 3-B3813A DEPOT Description: 0.00000
> |3-E4471A DEPOT 0.00000 B0 " "
16 ACCS-CRD-12WH  DEPOT 0.00000 Tip: Name Macro #1 "Format
1/ PHON-GTE-5043  NORTH 0.00000
18 PHON-PAN-2315 NORTH 0.00000 \_ J
19 PHON-ATT-0712  NORTH 0.00000 z
2U PHON-ATT-5354 NORTH 0.00000 0.00000 26.00000 0.00000
21 PHON-ATT-53BK  NORTH 0.00000 0.00000 22.00000 0.00000
22 PHON-ATT-53BL  NORTH 0.00000 0.00000 13.00000 0.00000
23 PHON-ATT-53RD NORTH Cancel 0.00000 0.00000 8.00000 0.00000
24 PHON-ATT-53WH NORTH 0.00000 0.00000 35.00000 0.00000
25 PHON-PAN-3848 NORTH Site 25.00000 0.00000 0.00000 25.00000 0.00000
2b 128 SDRAM NORTH Site 51,681.00000 0.00000 0.00000 51,681.00000 0.00000




Format Data and Page Setup

File Home Insert Draw Page Layout Formulas Data Review

I colors ~ Ny L = widt
==l s v @ DD Il Dé’ L B2 Heig

Themes Margins Orientation Size  Print Background Print o
v Effects v v 3 v Areav Titles li_] Scale

Themes Page Setup N St

- fx ltam Numher

Page Setup ? X

>
=y

Page Margins  Header/Footer Sheet flar

Print grea:

M

Print titles

LX~0U PUun =

2

Rows to repeat at top: $1:41

M

Columns to repeat at left:

Print

| Comments and notes:  (None) v
|:| Black and white

[ oraft quality
D Row and column headings

Cell grrors as: displayed ™

Page order

@ Down, then over EEE' E ETE‘E
O Over, then down EE HIE =5

Print... Print Preview Options...

Cancel

4374 AFFTTR TPTRTVAT T TTTITT

R

wwwwwwtluwwwww—-
SmmmooUnNONEE B




P smartList - TWO (sa)

Create the Export Solution

E By - & = | ="

722 H hsEMOE R & @

Mew Modify Search Refresh Columns Favorites Print Excel Word  Stop Export/lmport File Tocls | Help

Actions Search e & Help
y3l [tem Quantities - _ltem Quantities [On Hand) Refresh
ltem Mumber Location Code Record Type OT¥ On Hand TV On Order ary Columns CTY Back Ordered

13-A244DA 01-NW Site 1 0 Favorites 0!
3-C292448 102G Site 5 0 Print 0
3-D265TA 102G Site 3 0 Excel 0
3-D2659A 102G Site 5 0 o 0
3-E4592A 107G Site (3 0 Publizh 0
4-E20944 1126 Site 2 0 0
3-E4592A 115G Site (1) 0 top 0
3-E4502A 122G Site M 0 Go To 0
3-E45924 126G Site 0 0 Back 0
4-E20944 1276 Site 1 0 Forward 0
3-E4552A 127G Site 1] 0 0
3-A35424 DEPQT Site 1 0 0
3-B3813A DEPOT Site 1 0 Fovorites Pame 1 0
3-E4T1A DEPOT Site T 0 w 0

pr—
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Export Solutions - TWO (trainingdynamao)

e @

Delete Save File Tools | Help

- - -

Actions File Tools | Help

= szl

Name: Open AP
@ Document: | C:\Usershamber\DropboxhTraining Dynarmo® ﬁ
Fancy COA Preparation Macro: Clear

Completion Macrao: _ Format|

Yisible To: Everyone v

Application: Excel v

'w'-:nks for Favorites:

= hj Payables Transactions ~

~-08 "
@) *Open AP

|l [%] Cash Requirements*

0= Discounts Expiring this Week*
|l E] Invoices by Vendor®

(0= Past Due Payables*

|l E] Payables Documents on Hold*
0= Payables Due Today*

O El Today's Payments*

M= Todav's Purchaces*

e




Using an Export Solution

P smartList - TWO (sa)

o

SmartList | Additional File

- -

Additional File

i @

_.__.:’._ = Y " ﬁ = IL_L ! .l" @ ﬁ =] §:':'
4 @5? - E L = T @ & |1& Ue j
Mew Modify Search Refresh Columns Favorites Print Word Stop Go To | Excel Export/lmport
Actions ltem Qty Options
3 Item Quantities - _ltem Quantities [0n Hand] Quick Export
Itern Murmber Location Code Record Type OTY On Hand QTY On Order OTY Allocated
3-A24404 01-MNW Site 1 0 0
5 n 2

A-rMA2AA 123 Cite

Oy Avvailable

1
2

Oy Back Ordered

0
n




Enabling Excel Reports
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Home » Administration » Administration

[ Microsoft Dynamics GP +

Transactions ~ Inquiry ~ Reports = Cards +

SmartList {§l My Reports ~ [@ Process Monitor Close All Windows 4. Exit
—
P " P Reporting Tools Setup - TWO (sa) X
FerErrr—— Administration : :
s omn s @X T st @ e
My Reports List S
Ao Setup Checkiist OK Cancel = Additional ~ File Print | Tools Help ftem
Microseft Dynamics GP Reports Workflow for Sharepoint - - - Reconcil
Excel Reports 4 System Actions Additional File - Help Remove
Reporting Services Reports :“‘"W;E-‘*B ‘:"""‘Y C
, . curity Roles rocess |
Seb
ST Alternate/Modified Forms and Reports “® Business
Other Reports " OData Repotting Services | Management Fieporter ‘ Power Bl OData User Act
SmartList Designer View Pending Approval User Delete Ci
Security Workflow Pending Approval User Classes System Level Remove
User Access | Sand i
User Security Location [Network Share v] Using SharePaint Oniine Repos
Field Level Security
System Password Repoits Directory C:AGP Excel Reportsh ﬁl vﬂ::r!
Actity Tracking General
Cumency ; . . Security
Exchange Table Work with your Partner to select Location and Setup SECLII'Ity Groups
Multicurrency Access pmpany
Euro Relationships User Level Setup
Registration General
B s Fleports Directory CAGP Excel ReportsiUser Reports' = Groups
Organizational Structure | Maifin 1
Intercompany
Longwage o
Payroll Tax R “ 4 laster |
eporting Services and Excel Reports Deployment Status
Vorkllow Setup pich Recow
Process Server P kit
; Home Edit Launch File Ov" Deployed: Reports for 1 companies are deployed. Tax Year
e Reporting Tools Setup X Not Deployed: Reports for 0 companies are not deployed. R
£ Fanancial Named Printers oport S
gy Financ Client Updates Report S
(3] Sales System Preferences Report P
7 SmartList Options Report N
5 N 4 Company E
iﬁ‘ DETiasa Company Enqulrv
* Administration Munt FP"“BI [ Redeploy 4l reports for selected companies fstem
Fiscal Periods 2 . Batch
Tax Details ] Print status for all companies : s
’ Inventory Tax Schedules Frint Status Repart Deploy Repoits o .
p Shipping Methods
g, PSTL Payment Terms
GP P Tools Bank
4, GP Pawer Credit Cards




Finding Excel Reports

m Microsoft Dynamics GP

@‘\?}' | Home » Sales »  Excel Reports

—

m Microsoft Dynamics GP -

Transactions = Inquiry = Reports = Cards -

¢ SmartList My Reports = B Process Monitor @ Close All Windows 1., Exit

|55 Import/Export

P

Sl & . B 8 il i}

e > [ - Z bl i -~
- Customers =i =i

Prospects i SOL Report Manager 7~

Salespeople Actions Modify My Reports MNew Reports
I All Sales Transactions
I Receivables Transactions Excel Reports (read only) ~
I Sales Order Transactions show results

Invoicing Transactions 4 Add Filter =
[ Recervables Batches : :

Renort List ||_ MName 4 QOption Series Category

eport Li
Microsoft Dynamics GP Aq T ] TWO SalesLinelterns Default C:\GP Excel Reportsi\Reports Sales TWO
Excel Reports | [ ] TW0O SalesLineltems Default CAGP Excel Reports'\\Data Connections  Sales TWO

] TWO SalesLi
[ ] TWO SaleslLi
[ ] TWO SalesLi
[ ] TWO SaleslLi
[ ] TWO SalesLi

Reporting Services Reports
SmartList Favorites
Other Reports

file.

[ ] TWO SalesLinelfems tems

"Data Connections” open in a new workbook. If you modify a
"\\Reports" option, the changes will be saved to the shared

TGP Excel Reports\\Data Lonnections | sales

TwWo




Formatting Excel Reports/Adding Pivot Ta

File Home Insert Draw Page Layout Formulas Data Review View
: ™~ 0] = -
0 - :
2 @ M iy
@ D I
Tables lllustrations Che
A2 hd fx
SOP Type ~ |SOP Number ~ Item Number - |Item Description
2 |Back Order BKO1001 SOFT-PHM-0001 Phone Mail System
3 |Back Order BKO1003 ACCS-HDS-2EAR Headset - Dual Ear
4 |Back Order BKO1006 ANSW-PAN-1450 Panache KX-T1450 answer
5 |Back Order BKO1007 4-E2094A Laserjet Printer
6 |Fulfillment Order FULORD1000  100XLG Green Phone
7 Fulfillment Order FULORD1000 256 SDRAM 256 meg SDRAM
8 |Fulfillment
9 Fulfillment; PivotTable from table or range ? X :
10 [Fulfillment{ seject a table or range L
11 |Fulfillment . T
- —| Table/Range: Table TWO SalesLineltems_Default £ ‘ I—
12 Fulfillment
13 |Fulfillment { Choose where you want the PivotTable to be placed
14 [Fulfillment @® New Worksheet
15 Fulf!llment O Existing Worksheet
16 [Fulfillment { |
17 |Fulfillment§ Locaton: ol i
18 [Fulfillment { choose whether you want to analyze multiple tables R
19 |Fulfillment D Add this data to the Data Model -
20 |Fulfillment
21 |Fulfillment - Cancel
22 [Fulfillment
23 |Fulfillment Order FULORD1008 PHON-BAS-0001 Phone Base
24 [Fulfillment Order FULORD1008 PHON-FGD-0001 Phones-Hands Free Dual Ear

bles




,0 Search
File Home Insert Draw Page Layout Data Review View Automate Developer Help Table Design
— i —
fo ol ==E® Rwepen Generl | B B g = s E
Paste [Ercopy ~ I B Mer $ % 9 @8 Conditional Formatas Cell Insert Delete Format
~  <¥ Format Painter ' & % =29 | Formatting > Table > Styles ¥ - v ~
Clipboard ] Font Alignment K] Number ~ Styles Cells
1269 - Jfx  =HYPERLINK([@[Document Number For Drillback]],[@[Document Number]])
A B C D E F G
1
, Document Type = ¢ Status
3 Credit Memo Closed
4
5 Invoice Open
& Payment Voided
7 mFayables Payments Zoom - TWO (sa) - x
8 Return
! 5
: Schedule Q @ @ i
10
T oK \t’ew Addmunal File | Toeols Help Add
L e ¥  Note
12 EII Actions | View | Additional | File | - Help
252 ATTRACTIO0001  Attractive Telephone Co. 5,000.00 No
269 ASSOCIATO001  Associated Insurance Inc. Payment No. 00000000000000114 0O Batch ID | LESSOM USER1 1,132.53 No
315 WESTAMER0001 WestAmerica Telephone Co. Date 1/413/2024 -+ Date Voided 0/0/0000 18,790.78 No
1288
1289 Vendor 1D ASSOCIATO0O1 Currency ID ZUss$ I
1290 Check Name Associated Insurance Inc.
1201
1292 Payment Method: Check Credit Card
1293 Cash EFT Electronic
1294 Checkbaok 1D UPTOWN TRUST Amount
1295 Document No. 110001 Unapplied | $1.13253
1296 Amount $1.132.53 Applied $0.00
1297 Comment Total $1.13263
1298 PO Number
1299
1300 Terms Discount Taken ‘ $0.00 Writeoff $0.00
1301 Terms Discount Available | $0.00
1302
1303 Apply Distribution HE:Cieate BeciGut
1304

1305

Example Report

 Amount i WWI
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Custom Reports Using SmartList Designer
* The example report started a SmartList Designer Report based on the

SQL View from Microsoft called Payables Transactions.

mSmartList Designer - TWO (sa) - X
9P XE w '@
6K Execute Delete Create File Tools | Help
Query Go To v A
Actions File - Help
List Name: ‘ _Payables Tix Drilback SLD Product: |Microsoft Dynamics GP v Series: |Purchasing ~ ‘
Database View Selected Fields X
(- ] PayablesTransactions A PayablesTransactions.Document Number A
i - [0 Voucher Number m PayablesTransactions.Document Amount
- [ Vendor ID m PayablesTransactions.Current Tne Amount
-~ [ Decument Type PayablesTransactions.Voided
- 4] Document Date PayablesTransactions.Vendor ID For Drillback
3 Decument Number PayablesTransactions.Document Number For Drillback
- @ Current Tne Amount >
-~ [ 1099 Amount < >
- (11058 Amount LIFE Relationship | K AutoLink
CI109% Amount LYR FieldN TableName2 FieldName2
71099 Amount ¥TD TableMame 1eldN ame ableMName ieldN ame
- [ 1099 Type from Vendo: > - > > bl
[ Account Number With
- [ Accounts Payable Acct
. [ Accrued Purchases Act v
.. [] Address 1 Filter x |
... [] Address 2 Field Mame Condition Value
. [] Address 3 v v A
. [ Amount Billed LIFE e
< 7 > v
Result's Preview I T-S0L Query I
Batch Number Vendor ID Vendor Name Document Type Document Date Document Number i
AB 100919 ABOOO1 Amber Bell Invoice 2027-05-15 00:00:00.... 'WOW AWESOME 8
AB 101523 SFORD Spencer Ford Invaice 2027-10-15 00:00:00....  SFORD -- OCT 2027 2
AB 123545 AMEX American Express Invoice 2027-04-12 00:00:00.... AMEX STMT 033127 1™
< >




Formatting Hyperlinks

* Use the HYPERLINK function to make a friendly name for the Drillback
field:

0 = 5 AutoSave v TWO _Payables Trx Drillback SLD... ™
art Draw Page Layout Formulas Data Review View Automate Deve
Calibri 11 VAT A = EE v 2% Wrap Text General
B I[U i ¢vAY | === == E $ v %
Iy Font Y Alignment Iy Nut

fx =HYPERLINK([@[Document Number For Drillback]],[@[Document Number]])

B C D l
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Custom Keyboard
Shortcuts vs.

Homepage Setup

>

LAA




What will you choose?

Custom Keyboard Shortcuts
* Open GP Windows

* Open External Files

e Open Websites

e Run Macros

Homepage Setup
* Quicklinks

* My Reports
e Reminders




Creating Navigation Pane Shortcuts

Paste

Mavigation Pane Options...

i;# Purchasing

Wy

Add Window...
Add SmartList...
Add Macro...

Add Web Page...
Add External Shortcut...

Folder

412/2027  Fabrikarn, Inc.  dynamicscon




Quickest Way to Create Window Shortcuts

ZIC Edit Tools Help

Add to Shortcuts

Print Setup...
Ctri+P

Hrint...

Ctri+W

Close

Vendor Credit Summary Inquiry

ltem Maintenance - TWO (amber)

=9 X

Save Clear Delete Copy Attach

Actions

T [®

Additional GoTo

- -

Additional GoTe

« {| @

File | Print Tools Help

- -

Item Number ‘

Short Description

Generc Description

‘ Class

Add to Shortcuts a

Print Setup...
&) Print..

Close




Keyboard Shortcuts

Shortcut Properties

* I Change the properties of this shortcut and choose OK. oK

= F3 - Vendor Maintenance | Cancel

windows: Purchasing - Vendor Maintenance | Help

Kevboard Shortcut: [More)

[None| ~
F2
F4

F5

F&

F7

Fa

F3

F10

F11

F12 v




Homepage Setup

m Microsoft Dynamics GP

- O X
@77/" ‘ Home» “" O e
Mi(m;cftDynami(; GP = Transactions ~ Inquiry = Reports ~ Cards ~
M- R
Home DynamicsCon's Homa Customize this page.
User Preferences - | mCuslomize Home Page - TWO (dynamicscon) - x
ToDo
> . —
g e @K TH oW U@
I Report Shortcuts A4
Startup Tasks OK Cancel Additional | File  Tools | Help
- - -
ez Actions | Additional | File | - | Help
Customize your home page
Modify the content and layout of your hame page
[ Home Page Defalts
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What will you choose?

Word Templates

e Create custom letters for
Customers, Vendors, and
Employees

* How to create new letters

* Using SmartList to create for
multiple records

Word Forms

* Used for emailing Sales and
Purchasing Forms

* Adding Logos
* How to prevent mistakes
* Accessing




Letter Templates

P Smartlist - TWO (sa)

i m Wendor Maintenance - TWO (sa) — X W —
! o = > YL 7 (i £ :‘ =3 = ﬁ ey
S 1 @ S ERY LI " @
x %‘l ﬁg T Mew Modify Search Refresh Columns Favorites Print Excel  Stop Export/lmport  Smartlist = Additional File = Tools = Help
] = g * 4 Merge™ - - - - -
Save Clear Delete Options | All-in-One File  Print | Tools Help Add Actions Prepare a Vendor Letter Optiens | Additional | File - Help
i - b
: = : Liote bl Vendors - 1099 Yendors Missing Tax Info Quick Export
= F'repare a Vendor Letter i - HE|p Vendor \DA Vendor MName 1098 Type DEA Last Check Date Last Purchase Date  Tax ID Number
] Letter Maintenance : . {ASSOCIATO0DT Associated Insurance Inc, Menemployes Compensation 2/8/2026 41272027
Yendor 1D ACET Status: Active > | BEAUMONTD001T  Beaumont Construction Monemployee Compensation 1/31/2024 411272027 169876654
Mame A, Trawvel Company BERGERONDOO1  Bergeron Communications Sol. MNenemployee Compensation 0/0/0000 0/0/0000
Short Name & Travel Class 1D AUS-NSW-M P COMMETENDDOT  Comnet Enterprises, Inc Monemployee Cempensation 1/31/2024 1/15/2024 548-365-557
AT s COMPUTERDOD1  Computer Training Systems Monemployee Compensation 4/21/2027 1/28/2024 520388001
Check Name favel Lompany DOLECKICOD01  Dolecki Catering Nonemployee Compensation 1/31/2024 1/27/2024
GARDMERSDOD1  Gardner Services Monemployee Compensation 472172027 471272027 897-615-833
Primary &ddress: GKCLEANIDDOT G & K Cleaning Monemployee Compensation 42172027 12/19/2023
= IMLINESEDDO1 Inline Service Systems Monemployee Compensation 1/31/2024 1/16/2024
Address 1D PRIMARY p id INTERNATOD0 International TeleCom Assoc, Monemployee Compensation 1/31/2024 1/23/2024
Contact Gireg Powel Phone 1 [238) 555-0101 Ewxt. 0000 INTERNATO003  Internaticnal Telephone Nonemployes Compensaticn 1/31/2024 171972024
Address 123 Riley Street Phone 2 [000) 000-0000 Ext, 0000 MULTINATOD01  Multinational Commmunications  Monemployee Compensation 1/31/2024 171372024
Fh 3 PERMIERS0OOD1 Premier System, Inc. Monemployee Compensation 0/0/0000 0/0/0000
ane RELIANCEQDO1 Reliance Systems, Inc. Monemployee Compensation 0/0/0000 0/0/0000
Fax [234) 555-0101 Et. 0000 SIGMATURDDDZ  Signature Services Menemployee Compensation 1/31/2024 12/9/2023
City Sydney TELECONMNODO1  Teleconnect Systems Inc. Monemployee Compensation 0/0/0000 1/7/2024
Siate HEw T ax Scheduls AUGHSWST+20 P WOODCONS0001 Wood Consulting Monemployee Compensation 0/0/0000 0/0/0000
ZIF Code 2086 5Shipping Method OWERMIGHT P
Country Code P UPS Zone
Country Auztralia
| Address D= endor Account
Purchase FPRIMARY p
Bemit To REMIT TO p Comment 1
Ship From PRIMARY p Comment 2
1033 s _ _
Options Address Acoounts E-mail
4 4 » ¥ |byVendorID ~|




Updating Letter Templates
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Letter Writing Assistant

File Edit Tools Help

Letter Maintenance
Use this window ta manage your existing letter templates, create new letter templates,
delete existing letter templates, or rename existing letter templates.

=a Fabrikam, Inc. 4/12/2027

Select a letter categony. Callection w
‘what would you like to do?
(O) Create a New Letter Final Natice
First Motice

© Edit an Esisting Letter
(O) Delete a Letter
(C) Rename Existing Letter

Cancel

@ AutoSave

82 <  SsecondNoti.. = Saved v

Add Invoice Fields ~ |

/c.

Customer Balance
Customer OverDue Balance
Customer Aging Date
Customer Aging Period 1
Customer Aging Period 2
Customer Aging Period 3
Customer Aging Period 4
Customer Aging Period 5
Customer Aging Period &
Customer Aging Period 7
Invoice Detail

Last M5F Check Date
Last Payment Date

Last Transaction Date

Last Transaction Amount

General ~ Add Company Fields v Add Customer Fields «
General ~

Menu Commands Custom Toolbars

L |-‘-|---E--|‘--1---|---1---|

|(<l
B «CompanyCity|
«LetterDatex

N

K «CustomerName»

: «CustomerContact»

- «CustomerAddress1»

. «CustomerCity», «CustomerStaten «CustomerZipy»

m Dear «CustomerContact»,

File  Home Insert Draw Design Layout Referenc Mailings Review View Develop Add-ins Help | = ||/ Editing ~

ipy

We have previously contacted vou about the outstanding invoice(s) on vour account, and we
have not received a response from vou. Your account has an outstanding balance of
«CustomerOverDueBalance». The following invoice(s) are overdue:
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Basic ins

Code

Custom XM... ~

XML Resource:

SOP Blank Invoice Form
Report Section:

File Home Insert Draw

BEE O

Visual Macros Add-

[ PageHeader

i Headertem

-{i% Header-Component Headser

{= Body

{ Footer-Comment 1

-{i% Footer-Comment 2

i.{i= FooterComponert Footer
{ Footer-Comment 4

“.{Z ReportFooter

B s

Layout  References

Aa Aa B T3 | [ Design Mode

DynamicsCon - SOP Blank Invoice Form Template.docx - C... = Saved v pel

Updating Word Form Templates

Amber Bell iy}

Mailings ~ Review View Developer Help Table Design  Layout ‘.D HiEd\ting'

S . @ "(", E;EI \H ‘“ 2 Add Source

Add-ins Add-ins [T £

XML Mapping Restrict | Document | | Field | (2 Remove Source
Pane Editing  Template List
Contrals Mapping Protect Templates  Microsoft Dynamics GP Templates
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XXXXXXXXXXKX

Fields:

=[5 Fields

5 (C)QTY Ordered
=] {C)QTY To Invoice
5] (C) Total Back Ordered
=] F/O Extended Price
£ F/O Markdown Amourt

{5 shemDescription
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=] "SOP_LINE_WORK ‘Actual
5] "SOP_LINE_WORK' Comme

Bill To: To:
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Purchase Order No. Customer D | Salesperson 1D | Shipping Method | Payment Terms | Req Ship Date | Master No.
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Microsoft Word Add-In

Developer Help [C‘] [f Editing v ]

L 45 Add Source
&

Document Field
Template List

Templates Microsoft Dynamics GP Templates b
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Making “Boo

marks” Visible

Word Options

General
Display
Proofing
Save
Language

Accessibility

Advanced

Customize Ribbon
Quick Access Toolbar
Add-ins

Trust Center

[] Use pen to select and interact with content by default

Image Size and Quality l@ Document1 ‘-‘]

[] Discard editing data®
E] Do not compress images in fi\e@

Default resolution:@ | 220 ppi v

Chart L@ Document1 V}

Properties follow chart data point@
Show document content

[ show background colors and images in Print Layout view
[_] Show text wrapped within the document window
Show drawings and text boxes on screen

Show bookmarks

[C] Show text boundaries

If you accidentally delete

a "Bookmark", the page

and section breaks will
break!

[_] show crop marks

[7] Show field codes instead of their values

Field shading: | When selected ~

[T] Use draft font in Draft and Outline views

Font Substitution...

[[] Expand all headings when opening a document®

) [ ot |




Come to My Other Session!!

ity

GP, SQL AND MACROS...

OPTIMIZING YOUR SYSTEM IS EASIER THAN EVER!

e

Wednesday at 2:45 PM (Room: Bluebell)
Presenters: John Arnold & Me g




Recommended GP Sessions!

* Database and Queries and SQL, OH MY...Demystified
* Tuesday at 4:30 PM (Room: Iris)
* John Arnold

* GP Reporting Tools Shootout and Comparison
* Wednesday at 8:30 AM (Room: Bluebell)
* David Feenstra

* How is my GP data stored? SQL Tables 101
* Wednesday at 1:15 PM (Room: Longs Peak)
* Chris Giesbrecht




Recommended GP Sessions! (continued)

* Build Intelligent Copilots with GP Data
* Tuesday at 3:15 PM (Room: Longs Peak)
* Mariano Gomez

* Solve Your Reporting Needs with SQL Reporting Services
* Thursday at 1:45 PM (Room: Iris)
* David Feenstra




AMBER BELL

Email: amber@trainingdynamo.com
Website: trainingdynamo.com
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